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ЛАБОРАТОРНАЯ РАБОТА №1 

 
ВЕКТОРНАЯ ГРАФИКА. ПОНЯТИЕ ПРИМИТИВОВ ВЕКТОРНОЙ 

ГРАФИКИ.  ЛИНИИ БЕЗЬЕ. ВЕКТОРНЫЕ ОПЕРАЦИИ НАД 
ПРИМИТИВАМИ 

 
 

1.1. Цель работы 
 

Изучение примитивов, аффинных преобразований и преобразований над 
замкнутыми объектами векторной графики на примере построения чертежа 
конструкции с помощью прикладного пакета программ CorelDRAW. 

 
1.2. Теоретические сведения 

 
Векторная графика – это использование геометрических примитивов, 

таких, как точки, линии, сплайны и многоугольники, для представления 
изображений в компьютерной графике. 

Векторная графика описывает изображение с помощью математических 
формул. Основное преимущество векторной графики состоит в том, что при 
изменении масштаба изображения оно не теряет своего качества, что показано 
на рис. 1.1. Отсюда следует и еще одно преимущество – при изменении 
размеров изображения не изменяется размер файла. 

 

             
                      

          a                            б                      в 
 

Рис. 1.1. Отличие растровой от векторной графики при изменении  
размеров объектов: 

а – исходное векторное изображение; б – иллюстрация, увеличенная  
в 8 раз как векторное изображение; в – иллюстрация, увеличенная в 8 раз как 

растровое изображение 
 
Основное отличие векторной графики от растровой – в принципе 

хранения изображения. Векторная графика описывает изображение с помощью 
математических формул. По своей сути любое изображение можно разложить 
на множество простых объектов, таких, как  контуры, графические примитивы 
и т.д. Любой такой простой объект состоит из контура (на рис. 1.2 изображен 
черным цветом) и заливки (серый цвет).  
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Рис. 1.2. Простой объект векторной графики 

 
Основное преимущество векторной графики состоит в том, что при 

изменении масштаба изображения последнее не теряет своего качества. Отсюда 
следует и другой вывод – при изменении размеров изображения не изменяется 
размер файла. Ведь формулы, описывающие изображение, остаются те же, 
меняется только коэффициент пропорциональности. С другой стороны, такой 
способ хранения информации имеет и свои недостатки. Например, если делать 
очень сложную геометрическую фигуру (особенно если их много), то размер 
«векторного» файла может быть гораздо больше, чем его «растровый» аналог 
из-за сложности формул, описывающих такое изображение. 

Из всего вышесказанного можно сделать вывод, что векторную графику 
следует применять для изображений, не имеющих большого числа цветовых 
тонов, полутонов и оттенков. Например, для оформления текстов, создания 
логотипов и т.п. 

Структуру любой векторной иллюстрации можно представить в виде 
иерархического дерева. В такой схеме сама иллюстрация занимает верхний 
уровень, а ее составные части занимают более низкие уровни иерархии. Для 
знакомства с основными элементами векторного изображения откроем в одном 
из векторных редакторов любую векторную иллюстрацию и выделим ее 
составные части, последовательно спускаясь с вершины дерева на его нижние 
ветви.  

Самый верхний иерархический уровень занимает сама иллюстрация, 
объединяющая в своем составе объекты, узлы, линии, заливки. Следующий 
уровень иерархии – объекты, представляющие собой разнообразные векторные 
формы. В большинстве редакторов для их отображения необходимо выбрать 
режим просмотра в виде каркаса. Например, в CorelDRAW для перехода в этот 
режим просмотра надо выбрать команду View →Wireframe (Вид → Каркас); в 
программе Illustrator – View → Outline; для Freehand – View → Keyline View. 

Следующий уровень иерархии составляют сегменты, которые выполняют 
функции кирпичиков, используемых для построения контуров (каждый контур 
может состоять из одного или нескольких сегментов). Начало и конец каждого 
сегмента называют узлами, или опорными точками, поскольку они фиксируют 
положение сегмента, «привязывая» его к определенной позиции в контуре. 

Контуром называется любая геометрическая фигура, созданная с 
помощью рисующих инструментов векторной программы и представляющая 
собой очертания того или иного графического объекта. 

Типичными примерами контуров могут служить окружность, 
прямоугольник  или   другие   графические   элементы   сложного   изображения  
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(в том числе и сегмент кривой линии). Замкнутый контур – это замкнутая 
кривая, у которой начальная и конечная точки совпадают. Примером 
замкнутого контура является окружность. В некоторых редакторах замкнутый 
контур называют фигурой. Открытый контур имеет четко обозначенные 
концевые точки. Синусоидальная линия, например, является открытым 
контуром. 
В основе векторной графики лежат математические представления о 

свойствах геометрических фигур. Как было сказано выше, простейшим 
объектом (примитивом) векторной графики является линия. Поэтому в основе 
векторной графики лежит математическое представление линии. 

Типичными примитивными объектами векторной графики являются: 
– точки; 
– прямые и ломаные линии;  
– многоугольники;  
– окружности и эллипсы;  
– кривые Безье;  
– текст.  
Этот список неполон. Есть разные типы кривых (Catmull–Rom сплайны, 

NURBS и т.д.), которые используются в различных приложениях. Рассмотрим 
некоторые из этих примитивов. 

Точка 
Точка на плоскости задается двумя числами (х, у), определяющими ее 

положение относительно начала координат. 
Прямая линия 

Известно, что для задания прямой линии достаточно двух параметров. 
Обычно график прямой линии описывается уравнением y = kx + b. Зная 
параметры k и b, всегда можно нарисовать бесконечную прямую линию в 
известной системе координат.  

Отрезок прямой, ломаная линия и многоугольник 

Для задания отрезка прямой надо знать еще несколько параметров, 
например координаты х1 и х2 начала и конца отрезка, поэтому для описания 
отрезка прямой линии необходимы четыре параметра. Ломаную линию можно 
представить в виде отрезков прямых. Многоугольник представляет собой 
замкнутую ломаную линию. 

 
Окружность и эллипс 

 Окружности, эллипсы, параболы, гиперболы и другие линии, уравнения 
которых не содержат степеней выше второй, относятся к кривым второго 
порядка. Прямые линии – это частный случай кривых второго порядка. 
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Отличаются кривые второго порядка тем, что не имеют точек перегиба. Самая 
общая формула кривой второго порядка может выглядеть, например, как 

 

05432
2

1
2 =+++++ ayaxaxyayax .   (1.1) 

 
Как видно, пяти параметров вполне достаточно для описания бесконечной 

кривой второго порядка. Для записи отрезка кривой второго порядка 
необходимо на два параметра больше. Для задания отрезка кривой третьего 
порядка надо количество параметров увеличить еще на три.  

 
Кривая Безье 

Кривая Безье –  это параметрическая кривая, задаваемая выражением 
 

               1t0,tbPtB
n

0i
ni,i <<⋅= ∑

=
)()( ,   (1.2) 

 
 

где     Pi       – функция компонент векторов опорных вершин; 
bi,n(t)  – базисные функции кривой Безье;  
t         – расстояние между точками, называемые также полиномами 
Бернштейна. 
Графически кривая Безье показана на рис. 1.3. 
 
 

Маркер управляющей
 линии

Управляющая
 линия  

 
 

Рис. 1.3. Кривая Безье 
 
Существует 3 вида кривых Безье: 
–  линейные; 
–  квадратные;  
–  кубические. 
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Линейные кривые Безье 
При n = 1 кривая представляет собой отрезок прямой линии, а опорные 

точки P0 и P1 определяют его начало и конец. 
 Параметр t в функции, описывающей линейный случай кривой Безье, 

определяет, где именно на расстоянии от P0 до P1 находится B(t). Например, 
при t = 0,25 значение функции B(t) соответствует четверти расстояния между 
точками P0 и P1. Параметр t изменяется от 0 до 1, а B(t) описывает отрезок 
прямой между точками P0 и P1, что и показано на рис. 1.4. 

P1

P0

t=0  
 

Рис. 1.4. Пример построения линейной кривой Безье 
 
 

Квадратные кривые Безье 
 
Для построения квадратной кривой Безье, показанной на рис. 1.5, 

требуется выделение двух промежуточных точек Q0 и Q1 из условия, чтобы 
параметр t изменялся от 0 до 1: 

– точка Q0 изменяется от P0 до P1 и описывает линейную кривую Безье;  
– точка Q1 изменяется от P1 до P2 и также описывает линейную кривую Безье; 
– точка B изменяется от Q0 до Q1 и описывает квадратную кривую Безье.  
 
 

P1

P0

P2Q0

Q1

t=0,25

B

 
 

Рис. 1.5. Пример построения квадратных кривых Безье 
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Кривые Безье высших порядков 
Для построения кривых высших порядков соответственно требуется и 

больше промежуточных точек. Для кубической кривой это промежуточные 
точки Q0, Q1 и Q2, описывающие линейные кривые, а также точки R0 и R1, 
которые описывают квадратные кривые. Построение кривой Безье высших 
порядков графически показано на рис. 1.6. 

 

R1

R0

P2

P3Q0

Q2

Q1

t=0,25

B

P1

P0  
 

Рис. 1.6. Пример построения кривых Безье высших порядков 
 

Применение кривых Безье в компьютерной графике 
Благодаря простоте задания и возможности удобно манипулировать 

формой кривые Безье нашли широкое применение в компьютерной графике для 
моделирования гладких линий. Поскольку кривая полностью определяется 
своей выпуклой оболочкой из опорных точек, последние могут быть 
отображены и использованы для наглядного управления формой линии. Кроме 
того, аффинные преобразования кривой (перенос, масштабирование, вращение) 
также легко могут быть осуществлены путём применения трансформаций к 
опорным точкам. Наличие выпуклой оболочки значительно облегчает задачу о 
точках пересечения кривых Безье: если не пересекаются выпуклые оболочки, то 
не пересекаются и сами кривые. 

Наибольшее значение имеют кубические кривые Безье. Кривые высших 
порядков при обработке требуют большего объёма вычислений и для 
практических целей используются реже. Для построения сложных по форме 
линий отдельные кривые Безье могут быть последовательно соединены друг с 
другом в сплайн Безье. Для того чтобы обеспечить гладкость линии в месте 
соединения двух кривых, смежные опорные точки обеих кривых должны 
лежать на одной линии.  

Текст 
В компьютерных шрифтах, таких как TrueType, Times New Roman и 

другие, каждая буква создаётся из кривых Безье.  
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Векторные операции, применяемые к примитивам  
Векторные графические редакторы типично позволяют вращать, 

перемещать, отражать, растягивать, скашивать, выполнять основные аффинные 
преобразования над объектами, комбинировать и группировать примитивы в 
более сложные объекты. 

Более сложные преобразования включают булевы операции на замкнутых 
фигурах: объединение, дополнение, пересечение и т. д. Векторная графика 
идеальна для простых или составных рисунков, которые должны быть 
аппаратно-независимыми или не нуждаться в фотореализме. Например, 
PostScript и PDF используют модель векторной графики. 

 
Операция «Группировка объектов» 

Операция «Группировка объектов» состоит в объединении двух или 
более объектов (контуров) в одну группу. С полученным таким образом, 
сгруппированным объектом, можно обращаться как с единым объектом. Его 
можно перемещать, поворачивать, растягивать и выполнять многие другие 
операции без искажения взаимного расположения и пропорций, входящих в 
него объектов. 

Для реализации данной операции в CorelDRAW предусмотрена команда 
Arrange → Group (Расположение → Сгруппировать). Предварительно перед ее 
применением следует выделить все объекты, которые необходимо объединить в 
группу, с помощью инструмента Pick (Указатель). Это осуществляют путем 
протягивания с помощью мыши прямоугольной рамки выделения, 
захватывающей все группируемые объекты. 

Каждый элементарный объект, сгруппированный в результате применения 
этой операции, сохраняет свои свойства. Поэтому при необходимости всегда 
можно выполнить обратную операцию – разгруппировать группу объектов 
командой Arrange → Ungroup (Расположение → Разгруппировать) либо с помощью 
«горячих клавиш» Ctrl+U и работать с каждым простым объектом индивидуально. 

При реализации операции группировки можно использовать несколько 
уровней группировки. В этом случае разгруппировка объектов происходит в 
обратном порядке с сохранением иерархии группировки. 

 
Операции  «Объединение  форм  объектов» 

Под Объединением форм объектов (Shaping) подразумеваются операции 
по созданию новых объектов в результате определенного взаимодействия 
исходных. В современных векторных редакторах предусмотрены различные 
варианты объединения объектов. Наиболее распространенными из них являются 
три процедуры, принцип действия которых основан на использовании базовых 
логических операций ИЛИ, И, И–НЕ. Рассмотрим особенности их реализации на 
примере редактора CorelDRAW. В CorelDRAW  предусмотрены три типа 
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операций по объединению объектов: слияние (weld) (рис. 1.7, а), исключение 
(trim) (рис. 1.7, б) и пересечение (intersection) (рис. 1.7, в).  

Перечисленные команды расположены в подменю, для отображения 
которого необходимо выбрать команду Arrange → Shaping (Расположение → 
Формирование): 

– слияние (weld) – это операция по формированию из нескольких 
объектов одного, область которого будет совпадать с областью расположения 
исходных объектов. После ее выполнения в результирующий контур входят все 
области нижнего и верхнего контура (логическая операция ИЛИ). Причем под 
областью нового контура (объекта) понимается часть плоскости, ограниченная 
результирующим контуром и расположенная внутри этого контура; 

 

      
 

а         б 

 
 
в 
 

 
Рис. 1.7. Примеры операций:  

а – слияние (weld); б – исключение (trim); в – пересечение (intersection) 
– исключение (trim) – здесь результирующий контур состоит из части 

нижнего объекта, не пересекающейся с верхним (операция НЕ). Действие 
команды Trim во многом подобно работе формы для выкраивания печенья из 
раскатанного листа теста. Команда удаляет те части объекта, которые 
перекрываются с другими;  

– пересечение (intersection) – в результирующий контур входят только 
пересекающиеся (общие) области объектов. Это аналог логической операции И. 

Полученный объект (контур) создается путем использования одной или 
нескольких операций по обработке форм объектов. В результате такой 
операции из нескольких объектов получается новый объект, обладающий 
свойствами самого верхнего из исходных объектов, участвующих в операции. 
Поэтому в отличие от рассмотренной ранее операции группировки здесь 
свойства составляющих объектов теряются. 
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Операция «Комбинирование объектов» 
 
Комбинированием называется операция по созданию одного объекта из 

нескольких, который обладает следующими тремя свойствами: 
– из объекта удаляются те области, в которых четное количество 

исходных объектов накладывалось друг на друга; 
– объект допускает редактирование своей формы с помощью контуров 

исходных объектов, которые при этом сохраняются; 
– цвет объекта будет совпадать с цветом самого нижнего исходного 

объекта. 
При этом скомбинированные объекты имеют различные контуры, но 

одинаковые свойства (цвет  контура, заливки, толщина контура). 
Данная операция выполняется с помощью Команды Arrange→Combine 

(Расположить→ Скомбинировать). Различие вышеприведенных операций 
графически представлено на рис 1.8. 

 

         
а      б    в 

 
Рис. 1.8. Пример операций:  

а – слияние; б – комбинирование;  в – группировка 

 
Достоинства и недостатки векторной графики 

Основные достоинства векторной графики: 
– существует возможность неограниченного масштабирования 

изображения без потери качества и практически без увеличения размеров 
исходного файла;  

–  изображение в векторной графике значительно легче редактировать, 
поскольку готовое изображение не является «плоской» картинкой из пикселов, 
а составлено из объектов, которые могут накладываться друг на друга, 
перекрываться, оставаясь в то же время совершенно независимыми друг от 
друга;  

– векторным программам свойственна высокая точность рисования (до 
сотой доли микрона);  

–  преобразование векторного изображения в растровое выполняется 
практически автоматически не только с помощью графических редакторов, но и 
буфера обмена Windows.  
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Однако у векторной графики есть недостатки: 
– практически невозможно осуществить экспорт изображения из 

растрового формата в векторный;  
– векторный принцип описания изображения не позволяет 

автоматизировать ввод графической информации, как это делает сканер для 
растровой графики;  

– в векторной графике невозможно применение обширной библиотеки 
эффектов (фильтров), используемых при работе с растровыми изображениями.  

 
1.3. Порядок выполнения работы 

 
1. Изучить теоретическую часть работы. 
2. Загрузить на ПЭВМ программу CorelDRAW. 
3. Запустить файл с указаниями к лабораторной работе №1, изучить 

данные указания и порядок выполнения лабораторной работы. 
4. Выполнить действия, представленные в указаниях к лабораторной 

работе. 
5. Исследовать операции  «Группировка объектов», «Обработка форм 

объектов», «Комбинирование объектов» векторной графики. 
6. Результаты работы в виде графических изображений вставить в отчет. 
7. Оформить отчет и защитить работу. 
 

1.4. Содержание отчета 
 

1. Цель работы. 
2. Описание порядка выполнения работы с приведением 

заключительных изображений, полученных в результате выполнения 
лабораторной работы. 

3. Выводы по работе. 
 

1.5. Контрольные вопросы 

1.  Что представляет собой векторная графика? 
2.  Какие преимущества векторной графики перед растровой? 
3.  Какие примитивы векторной графики вы знаете?  
4.  Как описываются примитивы в векторной графике?  
5.  Что такое кривая Безье? 
6.  Какие виды кривых Безье вы знаете? 
7.  Какое применение кривые Безье находят в векторной графике? 
8.  Опишите алгоритмы построения кривых Безье различных порядков. 
9.  Какие операции «Обработки форм объектов» вы знаете? 

     10. Назовите основные различия операций «Группировка объектов», 
«Обработка форм  объектов» и «Комбинирование объектов». 
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Лабораторная работа №2 
 

ВЕКТОРНАЯ ГРАФИКА. ИЗУЧЕНИЕ  ВЕКТОРНЫХ И РАСТРОВЫХ 
ЭФФЕКТОВ В ВЕКТОРНОЙ ГРАФИКЕ 

 
2.1. Цель работы 

 
Изучение основных векторных и растровых эффектов на объектах 

векторной графики  на примере моделирования изделия РЭА с помощью 
прикладного пакета программ CorelDRAW. 

 
2.2. Теоретические сведения 

 
В программах векторной графики к объекту  можно применить два вида 

эффектов: векторные и растровые. 
 

Векторные эффекты 
Программа CorelDRAW представляет пользователю широкие возможности 

по созданию художественных эффектов в объектах векторной графики. Всего 
таких эффектов  десять: 

– переход (blend);  
– контур (contour);  
– искажение (distortion); 
– оболочка (envelope); 
– выдавливание (extrude);  
– тень (drop shadow);  

   – интерактивная прозрачность (interactive transparancy);  
– линза (lens); 
– перспектива (perspective); 
– фигурная обрезка (power cIip). 
Все они, кроме эффекта «Интерактивная прозрачность», формируются с 

помощью соответствующих команд меню Effects (Эффекты), а первые семь – 
также и интерактивными рабочими инструментами, расположенными в десятой 
ячейке блока инструментов программы.  

Следует отметить, что в отличие от растровых эффектов векторные 
эффекты применяются к объекту векторной графики непосредственно без 
каких-либо предварительных преобразований объекта. На панели инструментов 
(рис. 2.1) представлены интерактивные эффекты, т.е. такие эффекты, свойства 
которых можно изменять в реальном времени с помощью специальных 
ползунков и сеток.   
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Рис. 2.1. Меню «Интерактивные эффекты» на панели инструментов 
 

Меню «Эффекты» содержит следующие команды: 
– adjust (настройка цвета) – содержит набор команд для корректировки 

окраски выделенного объекта. Сюда входят такие команды, как улучшение 
контраста, тоновые кривые, автоматическая настройка цвета и т.д.; 

– transform (преобразование). Под трансформацией векторного объекта 
понимается изменение его формы или ориентации путем выполнения двух 
групп операций:  

– масштабирование (изменение размеров), поворот, наклон и    зеркальные 
развороты (по горизонтали и вертикали) объекта; 

– различные операции обработки контура объекта; 
– correction (корректирование) – данная настройка содержит одну 

команду, позволяющую со сканированного изображения удалять следы пыли, 
царапины, грубые помарки; 

– artistic media (художественные средства) – позволяет рисовать 
фигурную линию, толщина которой переменна и определяется ее стандартным 
профилем, выбранным на панели свойств (рис. 2.2). Под этим именем 
объединены сразу пять инструментов, которые позволяют создавать необычные 
графические обводки. Выбрать тип инструмента можно при нажатии 
соответствующего рисунка на панели свойств в ее левой части; 

 
 

 
 

Рис. 2.2. Графическая обводка (инструмент – «Художественные средства») 
 

– blend (переход). Эффект перехода состоит в следующем. Из двух 
исходных векторных объектов, расположенных на некотором расстоянии друг 
от друга, формируется комбинированный объект (объект перехода), состоящий 
из двух базовых элементов и группы промежуточных. В качестве базовых 
элементов используются исходные объекты, а промежуточные элементы, 
формируемые программой автоматически, обладают следующими свойствами: 
их геометрические и цветовые параметры плавно изменяются при переходе от 
одного базового элемента к другому, что и показано на рис. 2.3. Параметры 
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эффекта регулируются с помощью управляющей конструкции инструмента, а 
также элементов управления панели свойств;  

 

 
 

Рис. 2.3. Пошаговое перетекание из круга в прямоугольник (количество 
шагов перетекания 6) 

 
– contour (контур) – эффект, напоминающий пошаговый переход. Он 

заключается в том, что вокруг выделенного объекта (рис. 2.4, а) на определенном 
расстоянии создаются подобные ему концентричные объекты.  

Допускается создание трех разновидностей эффекта контура:  
–  tо center (к центру) – витки равномерно заполняют всю внутреннюю 

область объекта;  
– inside (вовнутрь) – заданное количество витков заполняет часть 

внутренней области объекта, примыкающую к его контуру (рис. 2.4, б);  
– outside (наружу) – заданное количество витков располагается снаружи 

от объекта, примыкая к его контуру (рис. 2.4, в); 
 

 

а        б            в  
Рис. 2.4. Векторный эффект «контур»:  

а – исходный объект; б – заданное количество витков заполняет часть 
внутренней области объекта, примыкающую к его контуру; в – заданное 

количество витков располагается снаружи от объекта, примыкая к его контуру 
 
Параметры эффекта регулируются с помощью управляющей конструкции 

инструмента, а также элементов управления панели свойств;  
–  envelope (оболочка) – с помощью данного эффекта можно задавать 

произвольное искажение векторных объектов. Суть искажения состоит в том, 
что объект вписывается во внешнюю оболочку. Создать оболочку можно тремя 
способами: вручную (рис 2.5 а), используя заготовки (рис. 2.5, б) и 
преобразовав в оболочку любую из «посторонних фигур». Параметры эффекта 
регулируются с помощью управляющих маркеров (узелков), расположенных 
вдоль контура оболочки и элементов управления панели свойств. 
Альтернативным средством настройки параметров эффекта оболочки является 
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докер Envelope (Оболочка), открываемый одноименной командой подменю 
Dockers (Докеры) меню Window (Окно); 

 

    
а         б 

 
Рис. 2.5. Создание оболочки:   

а – вручную; б – используя заготовки 
 

–  extrude (выдавливание) – имитируется вид в перспективе объемного 
объекта, полученного в результате добавления некоторой толщины к 
исходному векторному объекту, имеющему плоскую форму, иначе  – 
псевдообъем. Эффект экструзии позволяет построить на рисунке проекцию 
обобщенного цилиндра – тела, образующегося при перемещении плоской 
фигуры в пространстве в направлении, перпендикулярном ее плоскости. 
Основные свойства данного эффекта можно изменить в дополнительном докере 
или панели свойств; 

–  lens (линзы).  Объект с примененным эффектом линзы становится 
полупрозрачным или изменяет свой цвет по определенным правилам, в 
зависимости от выбранного типа линзы. Каждый  из режимов линзы имеет свои 
настройки, однако некоторые из них повторяются; 

–  add perspective (добавить перспективу) – средство для автоматического 
построения эффектов, имитирующих объем и глубину сцены; 

–  power clip (фигурная обрезка) – содержит четыре команды: place inside 
container (поместить в контейнер), extract contents (извлечь из контейнера), edit 
contents (править содержимое), finish edit this level (завершить изменения 
данного уровня). Поэтапное помещение объекта в контейнер показано на 
рис. 2.6, а, б, в; 

 

 
     а            б                в  

 
Рис. 2.6. Создание контейнера: а – объект, который должен стать 

контейнером; б – исходный объект; в – объект, помещенный в контейнер 
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– rellover (интерактивная кнопка) – эффект для создания элемента  
веб-дизайна, который изменяет свой внешний вид в зависимости от 
состояния указателя мыши; 

–  copy effect (копировать эффект) – копирует на выделенный объект 
эффект, примененный к другому объекту; 

–  interactive distortion (интерактивное искажение) – происходит 
искажение формы исходного векторного объекта (рис. 2.7, а) по закону, 
определяемому выбранным типом искажения, и с параметрами, заданными 
пользователем. Предусмотрены три разновидности эффекта искажения (типов 
искажения): push and pull (выпуклость и вогнутость) (рис. 2.7, б), zipper (зигзаг) 
и twister (скручивание) (рис. 2.7, в). Параметры эффекта регулируются с 
помощью управляющей конструкции инструмента и элементов управления 
панели свойств; 

 

 
 

                                    а     б             в  

Рис. 2.7. Эффект искажения:  
а – исходный объект; б – выпуклость и вогнутость; в – скручивание 

 
–  interactive shadow (интерактивная тень). В CorelDRAW тенью 

называется монохромное пиксельное изображение, автоматически 
формирующееся в составе соединенного объекта класса «падающая тень». В 
качестве управляющего в таком соединенном объекте выступает объект (или 
группа объектов), отбрасывающий тень. Поэтому все изменения, вносимые в 
управляющий объект, влияют на форму тени. Предусмотрено пять 
разновидностей эффекта тени (типов тени), которые определяют положение 
плоскости, на которую объект отбрасывает тень: flat (сзади), bottom (снизу), 
тор (сверху), left (слева) и right (справа). Параметры эффекта регулируются с 
помощью управляющей конструкции инструмента и элементов управления 
панели свойств. 

Растровые эффекты 
Растровые эффекты применяются к объекту векторной графики только 

после конвертирования данного объекта в растровое (битовое) изображение. 
Данное действие реализовано через команду меню «Битовые изображения» → 
→ «Конвертировать в битовое изображение». Таким образом, существует 
возможность преобразовывать векторное изображение в растровое с 
применением различных цветовых форматов. 
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Существует множество растровых эффектов, которые можно применить к 
битовому изображению. Все они представлены в меню Bitmap (Битовые 
изображения)  и перечислены ниже: 

– 3D-эффекты – искажают плоское пиксельное изображение таким 
образом, что оно начинает казаться трехмерным. Наиболее часто в этой 
категории используются эффекты:  

–  emboss (рельеф), преобразующий изображение в совокупность выступов 
или углублений при боковом освещении; 

– page curl (отогнутый уголок), имитирующий загиб угла листа бумаги с 
пиксельным изображением; 

– art strokes (художественные мазки) – сведены эффекты, имитирующие 
традиционные художественные приемы рисования – от рисунка итальянским 
карандашом или углем до акварели и пуантилизма; 

– blur (размывание). Путем размывания смягчают резкость пиксельных 
изображений, имитируют тени, туман, движение. Наиболее часто используемые 
эффекты – gaussian blur (размывание по Гауссу) и motion blur (движение); 

– camera (камера) – имеется всего один эффект, имитирующий диффузное 
рассеивание света в оптике фотокамеры; 

– color transform (цветовые преобразования) – сведены четыре эффекта, 
которые настолько радикально изменяют цветовую гамму пиксельного 
изображения, что назвать это цветовой коррекцией не представляется 
возможным. С их помощью можно свести цветовую гамму к базовым цветам, 
заменить цвета яркими, броскими оттенками, сделать изображение похожим на 
фотоснимок при съемке против света; 

– contour (контуры) – позволяет акцентировать в пиксельном изображении 
кромки – линии, по которым соприкасаются контрастно окрашенные области. 
Есть возможность задавать критерии поиска кромки, выбирать способ ее 
акцентирования и задавать цвет кромки; 

– creative (творческий) – в эту категорию входят 14 эффектов CorelDRAW. 
Они преобразуют исходное пиксельное изображение в различные виды мозаик 
и текстур. В качестве элементов мозаик могут выступать шарики, дождевые 
капли и многое другое; 

– distort (искажение) – искажают пиксельное изображение без образования 
иллюзии трехмерности. В эту категорию входят, например, такие эффекты, как 
tile (плитка), уменьшающий изображение и многократно повторяющий его в 
виде кафельных плиток с росписью, swirl (завиток) и wet paint (мокрая краска); 

– noise (шум) – эффекты, позволяющие работать с визуальным шумом – 
случайным образом распределенными по площади рисунка пикселами. 
Эффекты позволяют добавлять шум к изображению, управлять его 
характеристиками и устранять нежелательный шум. Особенно полезными в 
практической работе являются эффекты: 
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 – diffuse (диффузное рассеяние), позволяющий устранять 
микроскопические просветы в пиксельных изображениях;  
–    dust and scratches (пыль и царапины) – позволяющий устранять 
пыль и царапины со сканированных фото;  
–     remove noise (устранить шум) и remove moire (устранить муар) – 
устраняют нежелательные узоры, возникающие на пиксельных 
изображениях при повторном растрировании с разрешением, отличным 
от исходного; 

– sharpen (резкость) – пять эффектов, изменяющих характеристики ребер – 
линий, ограничивающих однородные фрагменты пиксельного изображения.  
После выбора любой из команд, соответствующих растровому эффекту, на 

экране раскрывается диалоговое окно, элементы управления которого 
обеспечивают возможность настройки управляющих параметров и режимов, 
присущих выбранному эффекту. 

 
2.3. Порядок выполнения работы 

 
1. Изучить теоретическую часть работы. 
2. Загрузить на ПЭВМ  программу CorelDRAW.  
3. Запустить файл с указаниями к лабораторной работе №2, изучить 

данные указания и порядок выполнения лабораторной работы. 
4. Выполнить действия, представленные в указаниях к лабораторной работе. 
5. Исследовать векторные эффекты программы CorelDRAW. 
6. Исследовать процесс преобразования векторного изображения в 

растровое и применить для полученного изображения основные растровые 
эффекты программы CorelDRAW. 

7. Результаты работы в виде графических изображений вставить в отчет. 
8. Оформить отчет и защитить работу. 

 
2.4. Содержание отчета 

 
1. Цель работы. 
2. Описание порядка выполнения работы с приведением заключительных 

изображений, полученных в результате выполнения лабораторной работы. 
3. Выводы по работе. 

 
2.5. Контрольные вопросы 

 
1. Какие векторные эффекты в CorelDRAW вы знаете? 
2. Чем отличается интерактивный эффект от эффекта, применяемого        

через «Главное меню»? 
3. Какие виды искажения объекта можно получить в CorelDRAW? 
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4. Что представляют собой растровые эффекты в CorelDRAW и для 
какого  изображения они применяются?  

5. Какие  растровые эффекты в CorelDRAW вы знаете? 
           6. Загиб листа бумаги – векторный или растровый эффект? 
           7. С помощью какого эффекта (векторного или растрового) создается    
тень объекта?          
           8. С помощью какого эффекта (векторного или растрового) можно                
удалить  пыль и царапины со сканированного изображения? 
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Лабораторная работа №3 
 

РАСТРОВАЯ ГРАФИКА. ОСНОВЫ РАБОТЫ В ПРОГРАММЕ 
PHOTOSHOP. 

 ПОНЯТИЕ СЛОЕВ. НАЛОЖЕНИЕ СЛОЕВ  
 

3.1. Цель работы 
 

 Изучение операций над слоями на примере графического исполнения 
изделия РЭА с помощью программы Photoshop. 
 

3.2. Теоретические сведения 
 

Понятие слоя, фоновый слой 
 
С помощью слоёв можно сделать то, что практически невозможно сделать с 

одним цельным изображением. Слои позволяют выделить часть изображения и 
работать с ней отдельно,  не меняя при этом остального изображения. Фрагмент 
рисунка на отдельном слое можно перемещать относительно фона. Слои также 
могут использоваться для раскрашивания чёрно-белого изображения 
(корректирующие слои). 

Слои похожи на прозрачные пленки, сложенные стопкой (рис. 3.1). На 
каждой пленке нарисован один объект, а остальная ее часть пуста (прозрачна). 
Если посмотреть на такую стопку сверху, то можно увидеть результат 
наложения изображенных на пленках объектов. 

 

 

Рис. 3.1. Понятие и представление слоя 

Всякое изображение в Photoshop имеет хотя бы один слой. Обычно 
изображение имеет несколько слоев, а каждый слой свои параметры (рис. 3.2). 
Однослойные изображения получаются в результате сканирования и открытия 
файлов в подавляющем большинстве графических форматов. 
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Единственный слой, который имеет большинство изображений, называется 
фоновым (Background) и отличается от прочих слоев. Основное отличие 
состоит в том, что фоновый слой не может иметь прозрачных областей.  

Layer 1

Background

Normal

 

Рис. 3.2. Параметры слоев 

Если  уподобить слои прозрачным пленкам, то фоновый слой  аналогичен 
листу бумаги. Фоновый слой всегда располагается под остальными слоями и 
служит фоном для размещенных на них объектов.  

Создание слоя 
Эта операция является ключевой в работе со слоями. Есть несколько 

способов создать новый слой. Создание «пустого» слоя производится двумя 
способами: через меню Layers→New→Layer (комбинация Shift+Ctrl+N) или 
нажатием на пиктограмму      группы управления слоями палитры Layers. Если  
новый слой создаётся первым способом, то возникает диалоговое окно, 
показанное на рис. 3.3. 

Layer 1

Normal

None

Name:

Color:

Mode:

(No neutral color exists for Normal mode)

 

Рис. 3.3. Создание нового слоя 

Алгоритмы 
наложения 

 

Запрещение 
действий 

 

Видимость слоя 

Управление  
прозрачностями 
 

 
 
 

Совершенно обычный слой 
 
 

Фоновый слой 
 
Название слоя 

Действия над слоями 
 
 
 

Название нового слоя 
 
 
 

Ключевой цвет 
 
 
 

Алгоритмы наложения 
 
 
 

Непрозрачность 
 
 
 

Сгруппировать с предыдущим слоем 
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Каждый слой можно назвать именем собственным. Это помогает отыскать 
его в большом количестве слоёв. Если  есть несколько слоёв, которые имеют 
какую-либо связь, то можно задать подкраску строки слоя в палитре Layers 
определённым цветом. Тогда становится понятным, что подкрашенные  
одинаковым цветом строки имеют определённую логическую связь. Этот 
ключевой цвет  можно выбрать в поле Color. Созданный слой полностью 
прозрачен, поскольку он новый и ничего не содержит. 

Необходимо  иметь  в виду, что все действия, которые  производятся, 
относятся только к активному слою. Активный слой легко отличить по «синей 
подсветке» его строки в палитре Layers и по пиктограмме с кисточкой        слева 
от его строки в палитре Layers. Для того чтобы сделать слой активным, 
необходимо просто щёлкнуть по его строке в палитре Layers.  

Как убедиться, что рисование на данном слое имеет отношение именно к 
этому слою? Для этого слева от строки слоя в палитре Layers кроме 
пиктограммы «активности» находится  кнопка-пиктограмма    , которая 
позволяет включить отображение слоя или выключить его. Если при 
отключении отображения вновь созданного слоя  рисунок исчез, значит,  всё 
сделано правильно. Если нет, то скорее всего  рисование проводилось не на том 
слое. Тут есть небольшая особенность – если отображение (видимость) слоя 
отключено, то на слое сделать ничего нельзя, пока он не активизирован  одним 
щелчком по пиктограмме, где раньше был «глаз» (он исчезает, когда 
выключается отображение слоя).  

Очень часто возникает необходимость создания нового слоя, который 
является точной копией старого, уже существующего. Этого результата можно 
достичь также несколькими способами. Первый способ – это команда меню 
Layer →Duplicate Layer. Далее последует диалоговое окно, в котором  можно  
задать настройки копии слоя (рис. 3.4). 

Name

 

Рис. 3.4. Дублирование слоя 

Поле As позволяет задать имя создаваемого дубликата. В разделе 
Destonation можно указать, куда копируется слой (в какой документ). Если 
открыто несколько документов, то в  выпадающем меню Document находится 
полный список открытых документов и вдобавок пункт New. Если необходимо 
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создать на базе копируемого слоя новый документ, то это именно то, что вам 
нужно. Ниже активируется поле Name, в которое требуется ввести имя 
создаваемого документа.  

Для преобразования фонового слоя в обычный прозрачный слой 
достаточно просто дважды щёлкнуть по его строке в палитре Layers. В ответ на 
эти действия появится диалоговое окно создания нового слоя. 

Наиболее сложным и часто используемым вариантом является создание 
слоёв из выделенных областей. Для этого создается выделение прямоугольной 
формы на фоновом слое документа. Копируется в буфер обмена выделенная 
область (либо меню Edit→Copy, либо сочетания клавиш Ctrl+C). Теперь, если 
вставить из буфера обмена скопированный ранее фрагмент (либо меню 
Edit→Paste, либо сочетания клавиш Ctrl+V), автоматически создастся новый 
слой, на котором будет находиться выделенная ранее область. Чтобы увидеть 
изменения, необходимо сделать фоновый слой невидимым с помощью кнопки-
пиктограммы       .  Подобное действие произведёт и вырезание (либо Edit→Cut, 
либо  сочетания клавиш Ctrl+X)) выделенной области в буфер обмена. 
Единственное отличие заключается в том, что на месте вырезанной области 
останется фрагмент фонового слоя, закрашенный в фоновый цвет. Если слой, из 
которого был вырезан фрагмент изображения, не является фоновым, то на 
месте вырезанной области будет прозрачная область в слое. Вставлять области 
изображения, находящиеся в буфере обмена, можно в любой документ. И в 
этом случае в качестве результата операции вставки будет новый слой. Эти 
операции можно также проделать и при помощи команд меню Layer. Команды 
находятся в меню Layer→New, соответственно Layer via Copy, что означает 
«создать слой путём копирования», и Layer via Cut  – «создать слой путём 
вырезки».  

Существует возможность создать уже заполненный слой. Для этого 
существует три варианта  слоев с различной заливкой:  

– слой со сплошной заливкой (solid); 
– слой с градиентной заливкой (gradient); 
– слой, залитый текстурной заливкой (pattern). 
 Для создания таких слоев можно воспользоваться командой из группы 

меню Layer →New Fill Layer. При выборе пункта Solid в первом диалоговом 
окне можно  настроить создаваемый слой, а во втором настроить цвет заливки. 
Если требуется слой с градиентной заливкой (Gradient), то сразу после 
диалогового окна создания слоя появится возможность настроить градиент, 
которым будет залит создаваемый слой. При создании слоя с текстурной 
заливкой (Pattern) выполняются те же действия. 

 Для удаления слоя требуется выделить строку слоя в палитре Layers и 
нажать  на  пиктограмму            в   группе  управления  слоями  палитры   Layers  
(рис. 3.2).  Другие способы – команда Delete Layer или из контекстного меню 
слоя или из меню Layer→Delete→Layer.  

В более новых версиях Photoshop есть такое понятие, как Layer Set (набор 
слоёв). Это не что иное, как папка для слоёв. То есть вы можете создать набор 
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слоёв, объединенных по какому-нибудь единому принципу. Обычно их 
объединяет общий режим наложения или использование какого-то одного 
цветового канала (рис. 3.5). 

 

Layer 4Layer 4

Layer 3

Layer 2

Layer 1

Set 1

Normal

 

Рис. 3.5. Понятие «Набор слоев» 

 Эти параметры можно задавать набору слоёв в целом, что облегчает 
работу с большим количеством слоёв. Также есть некоторые средства работы 
со всеми слоями, воздействие которых можно ограничивать для выбранного 
набора слоёв.  

Работа с набором слоёв аналогична работе с файлами и папками в файловом 
менеджере (например в проводнике). Прежде всего можно создать папку. Это 
делается командой New Layer Set (рис. 3.6) группы команд New из меню Layer или 
нажатием кнопки [ ] из группы управления слоями палитры Layer.  

 

Рис. 3.6. Установка параметров нового слоя 

Среди настроек есть возможность изменения имени набора, ключевого цвета 
и режима наложения. Единственное новшество – это режим наложения Pass 
Through, что означает «пройти насквозь», т.е такой режим наложения, при 
котором все слои ведут себя как единое целое. Для того чтобы добавить слой в 
набор слоёв, достаточно просто перетащить его строку в палитре Layers на значок 
вашего набора слоёв в палитре Layers. Чтобы убрать слой из набора слоёв, его 
точно так же нужно перетащить на значок набора слоёв в палитре Layers. 

Набор слоев 

Слои, входящие в набор 
Слои, 

не входящие 
в набор 
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Рядом  с  названием  набора  слоёв   слева  находится  треугольник       ,        
(см. рис. 3.5), при нажатии на который все строки слоёв, входящие в их набор, 
скрываются, а при повторном нажатии опять демонстрируются. Свойства 
набора слоёв можно вызвать из контекстного меню иконки набора слоёв 
командой Layer Set Properties. Флажки RGB позволяют указать, какие цветовые 
каналы можно отображать, а какие не отображать. 

 

Трансформация слоя 
Слой подлежит любой трансформации точно так же, как и выделенная 

область. Можно вертеть слой, изменять его размеры, искажать и пр. Для 
перемещения слоя служит инструмент под названием Move Tool, который 
расположен вверху справа на палитре инструментов. Этот инструмент можно 
вызвать также клавишей V.  

Если при перемещении слоя удерживать нажатой кнопку Shift, то слой 
будет перемещаться строго в выбранном направлении – по горизонтали или по 
вертикали. Если при перемещении удерживать нажатой клавишу Alt, то 
получается копия слоя.  

Трансформация слоя происходит в так называемом режиме Free Transform. 
В этот режим можно войти двумя способами: меню Edit →Free Transform или 
комбинацией Ctrl+T. Принципы работы в этом режиме полностью аналогичны 
принципам работы с режимом Transform Selection в случае выделенных 
областей. Для работы с изображением есть маркеры на габаритном боксе, есть 
горячие клавиши Alt – симметричное изменение размеров, Shift – 
пропорциональное изменение размеров, Ctrl – работа с каждым маркером по 
отдельности (рис. 3.7). Для выхода из режима достаточно нажать Enter. 

 

 

Рис. 3.7. Понятия «маркеры» и «габаритный бокс» 
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Также предусмотрена точная трансформация слоя. Для этого в меню Edit 
есть набор команд Transform. Первые пять команд – Scale, Rotate, Skew, Distort, 
Perspective (Масштаб, Поворот, Наклон, Искажение, Перспектива) находятся на 
панели преобразования слоя, с помощью которой можно выполнить все эти 
операции (рис. 3.8). 

Набор полей «Управление смещением слоя» – это аналог простого 
передвижения слоя инструментом Move. Обратите внимание на первую 
пиктограмму этой группы настроек. Смещение происходит всегда 
относительно какой-либо точки. По умолчанию эта точка расположена в 
геометрическом центре слоя. 

 

Рис. 3.8. Панель преобразования слоя 

Чтобы изменить положение точки, относительно которой и будет 
происходить смещение, достаточно щёлкнуть на маленьком прямоугольнике, 
символизирующем положение точки смещения. После выбора точки смещения 
в полях X и Y указываются абсолютные координаты, на которые нужно 
передвинуть слой, либо, нажав кнопку       и  перейдя в режим относительных 
координат смещения, указать, на сколько пикселей нужно сместить по 
горизонтали и по вертикали  слой. 

Набор полей «Масштабирование слоя» предназначен для изменения 
размера слоя. В процентах задаётся приращение размера по горизонтали и по 
вертикали. Для изменения размеров слоя пропорционально нажмите на 
пиктограмму        , которая расположена между полями приращения по 
вертикали и по горизонтали. 

В поле «Поворот слоя» можно задать угол поворота слоя. По умолчанию 
поворот происходит по часовой стрелке. Если угол поворота задать в виде 
отрицательного значения, то поворот произойдёт против часовой стрелки.  

Набор полей «Горизонтальный и вертикальный сдвиг слоя» служит для 
задания соответствующих углов сдвига. Основными параметрами сдвигов 
являются углы, на которые отклоняются вертикальные стороны габаритного 
бокса в случае горизонтального сдвига, и горизонтальные стороны – в случае 
вертикального сдвига (рис. 3.9). 

 

Масштабирование слоя 
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Рис. 3.9. Углы сдвига слоя 

Завершает панель свойств две команды:  
– exit (выход из режима трансформации); 
– edit (произвести изменения, утверждение внесённых трансформаций).  
На клавиатуре соответственно Enter – это подтвердить изменения, Esc – 

отменить изменения. 
В группе команд Transform также есть наиболее часто используемые 

команды, такие как повороты на стандартные углы: 
– rotate 180 – поворот слоя на 180°;  
– rotate 90 CW – поворот слоя на 90° по часовой стрелке;  
– rotate 90 CCW – поворот слоя на 90° против часовой стрелки;  
– flip horizontal – зеркальное отражение по горизонтали;  
– flip vertical – зеркальное отражение по вертикали.  

Операции блокировки слоёв 
Блокировки слоёв предназначены для предохранения слоя от 

несанкционированных операций пользователя. Кнопки блокировки 
находятся в верхней части палитры Layers, см. группу иконок «Запрещение 
действий» (рис. 3.10). 

Layer 1

Background

Normal

 

Рис. 3.10. Способы блокировки слоев 

Алгоритмы 
наложения 

 

Запрещение 
действий 
 

Видимость слоя 

Управление 
прозрачностями 

 

Совершенно обычный слой 
 
Фоновый слой 
 
Название слоя 

 

Действия над слоями 
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Блокировать можно прозрачность – это пиктограмма   . Блокировать 
прозрачность Preserve Transparancy означает не разрешить заполнение 
прозрачных фрагментов слоя. Это довольно часто используемый приём. 
Далее идёт блокировка слоя от рисования       .  Это запрет на изменение 

каких-либо пикселей на слое. 
Блокировка на перемещения слоя   . Этим запретом не разрешается 

применение инструмента Move и любое другое движение слоя, в том числе и 
операция Free Transform. 
Последняя пиктограмма        применяет все блокировки одновременно. 
 

Прозрачность и заливка слоя  
      Поля  Opacity  (Прозрачность)  и   Fill  (Заливка)  находятся  вверху палитры 
Layers (рис. 3.10). 
Что такое непрозрачность, вы уже знаете на примере работы с 

инструментами рисования. Для слоя непрозрачность имеет тот же смысл, что и 
для инструментов рисования, только в данном случае изменение прозрачности 
относится ко всему слою в целом. То же самое касается и алгоритмов 
наложения.  
Понятие заливки практически полностью аналогично понятию 

прозрачности. Однако необходимо иметь в виду, что на прозрачности, заданной 
через Fill, нельзя применить некоторые эффекты, связанные с прозрачностью. 
 

3.3. Порядок выполнения работы 
 

1. Изучить теоретическую часть работы. 
2. Загрузить на ПЭВМ  программу Photoshop .  
3. Запустить файл с указаниями к лабораторной работе №3, изучить 

данные указания и порядок выполнения лабораторной работы. 
4. Выполнить действия, представленные в указаниях к лабораторной работе. 
5. Исследовать способы создания слоев. 
7. Результаты работы в виде графических изображений вставить в отчет. 
8. Оформить отчет и защитить работу. 

 
 

3.4. Содержание отчета 
 

1. Цель работы. 
2. Описание порядка выполнения работы с приведением заключительных 

изображений, полученных в результате выполнения лабораторной работы. 
3. Выводы по работе. 
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3.5. Контрольные вопросы 
 

  1. Что такое слой? 
  2. Что такое фоновый слой? 
  3. Какие операции можно выполнять с фоновым слоем? 
  4. Как создать новый слой? 
  5. Какие виды трансформации слоев существуют? 
  6. Что такое угол сдвига слоя? 
  7. Как изменить угол сдвига слоя? 
  8. Что такое блокировка слоя? 
  9. Какие виды блокировки слоев существуют? 
  10. Как уменьшить прозрачность слоя? 
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Лабораторная работа №4 
 

ФРАКТАЛЬНАЯ ГРАФИКА. ПОСТРОЕНИЕ ФРАКТАЛОВ  
С ПОМОЩЬЮ ПРИКЛАДНОГО ПАКЕТА ПРОГРАММ PHOTOSHOP 

 
 

4.1. Цель работы 
 

Изучение объектов фрактальной графики, методов их построения  
и создание фрактала с помощью программы Photoshop. 

 
4.2. Теоретические сведения 

 
Понятия фрактал и фрактальная геометрия, появившиеся в конце 70-х гг. 

ХХ века, с середины 80-х прочно вошли в обиход математиков и 
программистов. Слово фрактал образовано от латинского fractus и в переводе 
означает состоящий из фрагментов. Оно было предложено Бенуа 
Мандельбротом в 1975 г. для обозначения нерегулярных, но самоподобных 
структур, которыми он занимался. Но только в наше время удалось объединить 
работы многих авторов, посвященных фракталам, в единую систему.  

Роль фракталов в компьютерной графике сегодня достаточно велика. Они 
приходят на помощь, например, когда требуется с помощью нескольких 
коэффициентов задать линии и поверхности очень сложной формы. С точки 
зрения компьютерной графики фрактальная геометрия незаменима при 
генерации искусственных облаков, гор, поверхности моря. Фактически найден 
способ легкого представления сложных неевклидовых объектов, образы 
которых весьма похожи на природные.  

Одним из основных свойств фракталов является самоподобие. В самом 
простом случае небольшая часть фрактала содержит информацию обо всем 
фрактале.  

Определение фрактала, данное Б. Мандельбротом, звучит так: 
фракталом называется структура, состоящая из частей, которые в каком-то 
смысле подобны целому.  

Классификация фракталов 
Чтобы представить все многообразие фракталов, удобно прибегнуть к их 

общепринятой классификации: 
– геометрические;  
– алгебраические;  
– стохастические. 
Существуют и другие классификации фракталов, например, деление 

фракталов на детерминированные (алгебраические и геометрические) и 
недетерминированные (стохастические).  
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Геометрические фракталы 
Фракталы этого класса самые наглядные. В двухмерном случае их 

получают с помощью некоторой ломаной (или поверхности в трехмерном 
случае), называемой генератором. За один шаг алгоритма каждый из отрезков, 
составляющих ломаную, заменяется на ломаную-генератор в соответствующем 
масштабе. В результате бесконечного повторения этой процедуры получается 
геометрический фрактал.  

Рассмотрим один из таких фрактальных объектов – триадную кривую 
Коха. Построение кривой начинается с отрезка единичной длины (рис. 4.1) – 
это нулевое поколение кривой Коха. Далее каждое звено (в нулевом поколении 
один отрезок) заменяется на образующий элемент, обозначенный на рис 4.1  
через n = 1. В результате такой замены получается следующее поколение 
кривой Коха.  

В первом поколении – это кривая из четырех прямолинейных звеньев, 
каждое длиной по 1/3. Для получения третьего поколения проделываются те же 
действия – каждое звено заменяется на уменьшенный образующий элемент. 
Итак, для получения каждого последующего поколения все звенья 
предыдущего поколения необходимо заменить уменьшенным образующим 
элементом. Кривая n-го поколения при любом конечном n называется 
предфракталом. На рис. 4. 1 представлены пять поколений кривой. При n, 
стремящемся к бесконечности, кривая Коха становится фрактальным объектом.  

 

n=1

n=0

n=5

n=4

n=3

n=2

 
Рис 4.1. Построение триадной кривой Коха 

 
Для получения другого фрактального объекта нужно изменить правила 

построения. Пусть образующим элементом будут два равных отрезка, 
соединенных под прямым углом. В нулевом поколении заменим единичный 
отрезок на этот образующий элемент так, чтобы угол был сверху. Можно 
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сказать, что при такой замене происходит смещение середины звена. При 
построении следующих поколений выполняется правило: самое первое слева 
звено заменяется на образующий элемент так, чтобы середина звена смещалась 
влево от направления движения, а при замене следующих звеньев направления 
смещения середин отрезков должны чередоваться. На рис. 4.2 представлены 
несколько первых поколений и 11-е поколение кривой, построенной по 
вышеописанному принципу. Предельная фрактальная кривая (при n, 
стремящемся к бесконечности) называется «драконом» Хартера–Хейтуэя.  

 

 
Рис. 4.2. Построение «дракона» Хартера–Хейтуэя 

 
 
В компьютерной графике использование геометрических фракталов 

необходимо при получении изображений деревьев, кустов, береговой линии. 
Двухмерные геометрические фракталы используются для создания объемных 
текстур (рисунка на поверхности объекта).  

Алгебраические фракталы 
Это самая крупная группа фракталов. Получают их с помощью 

нелинейных процессов в n-мерных пространствах. Наиболее изучены 
двухмерные процессы. Интерпретируя нелинейный итерационный процесс как 
дискретную динамическую систему можно пользоваться терминологией теории 
этих систем: фазовый портрет, установившийся процесс аттрактор и т.д.  

Известно, что нелинейные динамические системы обладают несколькими 
устойчивыми состояниями. То состояние, в котором оказалась динамическая 
система после некоторого числа итераций, зависит от ее начального состояния. 
Поэтому каждое устойчивое состояние (или аттрактор) обладает некоторой 
областью начальных состояний, из которых система обязательно попадет в 
рассматриваемые конечные состояния. Таким образом, фазовое пространство, 

Би
бл
ио
те
ка

 БГ
УИ
Р



 35 

системы разбивается на области притяжения аттракторов. Если фазовым 
является двухмерное пространство то, окрашивая области притяжения 
различными цветами, можно получить цветовой фазовый портрет этой системы 
(итерационного процесса). Меняя алгоритм выбора цвета, можно получить 
сложные фрактальные картины с причудливыми многоцветными узорами. 
Неожиданностью для математиков стала возможность с помощью примитивных 
алгоритмов порождения очень сложных нетривиальных структур.  
          В качестве примера рассмотрим множество Мандельброта (pис. 4.3).  

 

 
 

Рис. 4.3. Множество Мандельброта 
 
Алгоритм его построения достаточно прост и основан на простом 

итеративном выражении:  
 

Z[i] [ ] [ ] [ ] CiZiZiZ ⋅⋅=+1 ,         
 

где  Z[i]  и C – комплексные переменные.  
Итерации выполняются для каждой стартовой точки C прямоугольной 

или квадратной области – подмножестве комплексной плоскости. 
Итерационный процесс продолжается до тех пор, пока Z[i]  не выйдет за 
пределы окружности радиуса, центр которой лежит в точке (0,0) (это означает, 
что аттрактор динамической системы находится в бесконечности), или после 
достаточно большого числа итераций (например 200–500) Z[i]  сойдется к 
какой-нибудь точке окружности. В зависимости от количества итераций, в 
течение которых Z[i] оставалась внутри окружности, можно установить цвет 
точки C (если Z[i] остается внутри окружности в течение достаточно большого 
количества итераций, итерационный процесс прекращается и эта точка растра 
окрашивается в черный цвет).  
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Вышеописанный алгоритм дает приближение к так называемому 
множеству Мандельброта. Множеству Мандельброта принадлежат точки, 
которые в течение бесконечного числа итераций не уходят в бесконечность 
(точки, имеющие черный цвет). Точки, принадлежащие границе множества 
(именно там возникают сложные структуры), уходят в бесконечность за 
конечное число итераций (рис. 4.4), а точки, лежащие за пределами множества, 
уходят в бесконечность через несколько итераций (белый фон).  

 

 
 

Рис. 4.4. Участок границы множества Мандельброта, увеличенный в 200 pаз 
 

Стохастические фракталы 
Еще одним известным классом фракталов являются стохастические 

фракталы, которые получаются в том случае, если в итерационном процессе 
случайным образом менять какие-либо его параметры. При этом получаются 
объекты, очень похожие на природные: несимметричные деревья, изрезанные 
береговые линии и т.д. Двумерные стохастические фракталы используются при 
моделировании рельефа местности и поверхности моря.  

 
Методы построения фракталов 

Существуют два основных метода построения фракталов. Первый метод – 
использование L-систем (от имени Lindenmayer), второй метод – применение 
системы итерирующих функций IFS (Iterated Function Systems) (рис. 4.5, а, б).  

L-система – это грамматика некоторого языка (достаточно простого), 
которая описывает инициатор и преобразование, выполняемое над ним при 
помощи средств, аналогичных средствам языка Лого (аксиоматическое 
описание простейших геометрических фигур и допустимых преобразований на 
плоскости и в пространстве). 
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а     б  
 

Рис. 4.5. Методы построения фракталов:  
а – пример построения дерева с помощью L-системы; б – изображение 

кривой Коха, полученное с использованием IFS 
 
Система итерирующих функций – это совокупность сжимающих 

аффинных преобразований. Как известно, аффинные преобразования включают 
в себя масштабирование, поворот и параллельный перенос. Аффинное 
преобразование считается сжимающим, если коэффициент масштабирования 
меньше единицы. 

Отметим, что L-системы предназначены для генерирования 
предфракталов заданного порядка. Это свойство отличает их от IFS, которые 
предназначены для построения самих фракталов. Метод, основанный на IFS, в 
отличие от L-систем считается перспективным методом синтеза фракталов, а 
также сжатия изображений. Помимо просто построения красивых изображений 
на экране компьютера, фракталы применяются в компьютерных технологиях в 
следующих областях: 

–  сжатие изображений и информации; 
–  скрытие информации в изображении и звуке; 
–  шифрование данных с помощью фрактальных алгоритмов; 
–  создание фрактальной музыки; 
–  моделирование систем; 
–  и другие. 
 

4.3. Порядок выполнения работы 
 

1. Изучить теоретическую часть работы. 
2. Загрузить на ПЭВМ  программу Photoshop .  
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3. Запустить файл с указаниями к лабораторной работе №4, изучить     
данные указания и порядок выполнения лабораторной работы. 

4. Выполнить действия, представленные в указаниях к лабораторной работе. 
  5. Исследовать методы и способы построения фракталов. 
  6. Исследовать процесс создания фракталов с помощью программы 

Photoshop. 
  7. Результаты работы в виде графических изображений вставить в отчет. 
  8. Оформить отчет и защитить работу. 
 

4.4. Содержание отчета 
 

1. Цель работы. 
2. Описание порядка выполнения работы с приведением заключительных 

изображений, полученных в результате выполнения лабораторной работы. 
3. Выводы по работе. 

 
4.5. Контрольные вопросы 

 
           1.  Что такое фрактал? 
           2.  Основное свойство фракталов. 
           3.  Как классифицируются фракталы? 
           4.  Что такое геометрические фракталы и как они строятся? 
           5.  Приведите пример построения геометрического фрактала. 
           6.  Что такое алгебраические фракталы? 
           7.  Приведите пример построения алгебраического фрактала. 
           8.  Что такое стохастические фракталы? 
           9.  Какие методы построения фракталов вы знаете? 
           10.Чем отличаются данные методы?           
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ПРИЛОЖЕНИЕ 
 

«Горячие» клавиши программы CorelDRAW 
 

Команды меню File (Файл) 
New (Новый) Ctrl+N 
Open (Открыть) Ctrl+O 
Save (Сохранить) Ctrl+S 
Import (Импорт) Ctrl+I 
Export (Экспорт)  CtrL+E 
Команды меню Edit (Редактировать) 
Undo (Отменить) Ctrl+Z 
Redo (Повторно выполнить) Ctrl+Shift+Z 
Repeat (Повторить) Ctrl+R 
Cut (Вырезать) Ctrl+X 
Copy (Копировать) Ctrl+C 
Paste (Вставить) Ctrl+V 
Delete (Удалить) Del 
Objects (Объекты) Ctrl+A 
Duplicate (Дублировать) Ctrl+D 
Copy Properties From (Копировать свойства из) Ctrl+Shift+А 
Команды меню View (Вид) 
Full-Screen Preview (Полноэкранный просмотр) F9 
Snap To Grid (Привязать к сетке) Ctrl+Y 
То Front (Вверх) Shift+PgUp 
То Back (Вниз) Shift+PgDn 
Forward one (На один вперед) Ctrl+PgUp 
Back One (На один назад) Ctrl+PgDn 
Group (Сгруппировать) Ctrl+G 
Ungroup (Разгруппировать) Ctrl+U 
Combine (Скомбинировать) Ctrl+L 
Break Apart (Разъединить) Ctrl+K 
Convert To Curves (Преобразовать в кривые) Ctrl+Q 
Convert Outline To Object (Преобразовать 
контур в объект) 

Ctrl+Shift+Q 

Команды меню Effects (Эффекты) 
Lens (Линза) Alt+F3 
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Команды меню Text (Текст) 
Format Text (Форматировать текст) Ctrl+T 
Edit Text (Редактировать текст) Ctrl+Shift+T 
Align To Baseline (Выровнять по базовой 
линии) 

Alt+F12 

Spell Check (Проверка орфографии) Ctrl+F12 
Change Case (Изменить регистр) Shift+F3 
Show Non-Printing Characters (Показать 
служебные символы) 

Ctrl+Shift+С 

Команды меню Tools (Инструменты) 
View Manager (Диспетчер видов) Ctrl+F2 
Graphic and Text Styles (Графические  
и текстовые стили) 

Ctrl+F5 

Symbols and Special Characters (Символы  
и спецсимволы) 

Ctrl+F11 

Команды меню Window (Окно) 
View Manager (Диспетчер видов) Ctrl+F2 
Graphic and Text Styles (Графические  
и текстовые стили) 

Ctrl+F5 

Symbols and Special Characters (Символы  
и спецсимволы) 

Ctrl+F11 

Refresh Window (Обновить окно) Ctrl+W 
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